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Nybbles & Bytes 
www.neopc.org 

Voice: 216-521-2907  

President’s Message: 
By Dick Rose 

The foremost topic this month is the Election of Officers which is to take place at our September 
General Meeting, Wednesday, September 10th, 2008. I am extremely pleased that our Steering Committee has 
once again provided Officer potential, exactly as it should. The Nominating Committee has come up with the 
following Slate of Officers for consideration for the coming year. 

Slate of Officers: President– Lee Gerber; 1st Vice President—Jim McIntyre; 2nd Vice President—
George Sikula; 3rd Vice President—Lee Twitchell; Treasurer– Ed Singler; Secretary—Carol Romano; Member-
at-Large—Mario Romano. 

The Election will take place at 7:00 pm sharp—remember nominations can be made from the floor at 
that time as long as the nominee has agreed ahead of time to accept the nomination. In the event that there 
are no additional nominees a motion will be made for the Secretary to cast one vote in behalf of the whole.  

Website / Forum Update 
By Dick Rose 

A few changes have taken place in the FORUM area—A new topic was introduced in the name of 
“Stuff is Happening” - Dave Vydra will include items of interest in the Computer industry—this category is 
open to the world in the interest of introducing NEOPC and  specifically to our position in the User Commu-
nity.  Watch that area as you explore the FORUM.  

The other “Members Only” categories of Fundamentals and Photography are extremely popular and 
all of you should make regular visits there to check it out. Keep in mind, as soon as you log in the first step 
should be to click on  “Active Topics” in the menu at the top of the screen.  This is how it works. Each time 
you login the Forum database keeps track of the date and time you were last logged in. Based on that—it col-
lects all the topics and replies introduced since then and displays them to you. Since we have quite a bit of 
activity you might be over-whelmed if you try to find where you left off  before. This is a great advantage—
utilize this feature. Above all—if you have any questions that are gnawing at you  - this is the place to ask for 
help.  The new “Photography” category is being monitored by our long time friend, and resident expert, 
Mike Volker. He lives quite a distance from here and is unable to make many meetings, but  this Forum con-
cept brings him as close as your computer screen—don’t hold back—ask away. 
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Through the Gates:  

Enter to the Trove of Bills Treasures and Travails 
 

A monthly column dedicated to revealing some of the unknown or lesser known features or foibles of the 
Microsoft line of products. 
 

By David A. Vydra 

 
And even more on. . . . . . 64bit!  Don’t you just love these echo articles? 

Hopefully, I won’t repeat myself overly often when it comes to this subject.  But, it has been quite 
some time since the last transition of this type.  I am sure that the majority has pretty much forgotten the 
warts left over from that.  This month it is just a matter of clearing up some loose ends.  Yet, these are points 
to continually keep in mind.  As the progression of the 64bit enabled system becomes ever increasing so will 
there be an increase of 64bit applications, enhancements and utilities.  I guarantee that you will encounter 
64bit versus 32bit options on many of the Microsoft download sites.  Similar options should become 
commonplace in most other download arenas.  Primarily, what we are looking at here is; the version type 
download request.  Already, you are required to select a language version on many.  Now, you will be asked 
to select the X64 or X86 version as well as the language for each where available.  There are initially two 
options to select.  These increase exponentially by two with each language option.  At times, you may be 
presented with a dozen or more possible selections.  It behooves you to look at and understand which one 
you want.  X64 is for the 64bit OS and X86 for the 32bit OS.  The language is en for either.  

You are no doubt asking; what difference does it make?  If I install the wrong one, will it mess up my 
system?  Most likely, there will be no adverse effects.  But, this is conditional.  If the download is from 
Microsoft, there will be a problem installing.  Depending on what the situation is, you will get a nag screen 
informing you of adverse action should you proceed.  Or, you will simply be informed that the install cannot 
proceed because you are attempting to install an incompatible version.  While an X86 version will install into 
a 64bit OS, an X64 version will not.  If the language version is inappropriate, you should see a nag screen.  
Read and understand it.  Let us say that you have downloaded an Australian version upgrade.  Outwardly, 
there will be little difference.  However, there is the likelihood that certain settings may be changed.  You may 
not be able to watch DVD movies or photos on a CD because the country code has been changed.  Or, you 
may see error boxes like this: 

                                    
 

(Continued on page 3) 

Crikey!  Internet Explorer has encountered a problem and must 
close. 

Please tell Microsoft about this. 
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Or, when you boot: 

                                                        
 

Seriously though, you will not have any problem if you download the correct version initially.  If you 
don’t, the biggest problem will that you will have to do the correct download which just means you will have 
to spend additional time.  Thus far, only a few vendors have developed 64bit versions of their applications.  
This number will continue to grow over time.  Just be alert and select the correct download as these choices 
become available.  We won’t know until after the fact if there will be problems should you select wrong.  Not 
every vendor application will be fine tuned to prevent installation errors.  Or, at least provide warnings 
during installation.  Remember, X64 is for the 64bit OS and X86 for the 32bit OS.  The language is en for 
either. 

 
The Olympics on Your PC! 

During the past Olympics, NBC streamed many of the events for viewing on your computer.  I hope 
you took the opportunity to check out some of the events.  If you did, what you were able to see was a 
monumental event.  The entirety of available events were streamed online using Microsoft’s Silverlight.  If 
you tried to view them and balked at the need to download and install the Silverlight plug-in, you missed 
quite a deal.  If you have not heard of it, Silverlight is the Microsoft answer to Adobe Flash.  If you do not 
visit the Microsoft site very often then it is likely you have not been asked to install Silverlight.  But, during 
the last year or so, Microsoft has revamped many areas of their site.  Not all pages use Silverlight.  However, 
for those that do, your experience will be enhanced by allowing the install.  Due to the recent spate of emails 
that lured unsuspecting souls into attempting to download the Adobe Flash plug-in it is only a matter of time 
before we see an attempt to do this with Silverlight.  To forestall this, I would recommend installing 
Silverlight toot sweet.  There is a link at Microsoft.com.  Or, you may use this one: http://
www.microsoft.com/silverlight/resources/install.aspx?v=2.0. 

At the same time, make sure that your Adobe Flash Player is also up to date.  Visit the Adobe web site 
for a link.  The email problem has been a wake up call to many.  Always ignore any suggestion that you need 
an update of any kind from an unknown web site.  For that matter, do not use a link for updates except if 
they are on the providers’ site to which you have inserted your own address.  As the operator, the onus is on 
you to be aware of what you have and to protect yourself. 

 
20 tips and tricks for enhancing your Vista experience.  (Some work with XP as well. 
1. If you hate the look of Aero, click Start/Control Panel/Themes and you can choose a non-Aero theme, 

such as Windows Classic. 
2. Windows Vista's installer can detect serial-ATA (SATA) drives without the need to provide a driver 

diskette. Don't bother creating a diskette for your SATA drives before you install Vista. 
3. Double-click a window's title bar to make it go full screen. Editing in little windows on the screen is a 

(Continued from page 2) 

(Continued on page 4) 

G’day Mate! 
You are signed in as: 
Enter Your Password: 
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hassle and requires unnecessary scrolling.  
4. If, for some reason, the Vista installation gets interrupted due to an unintentional shutdown or reboot, 

start the computer without booting the Vista DVD. Windows Vista's installer should pick up where it left 
off. If it doesn't, then restart the installation over from scratch.  

5. When you perform a search with Vista's new, instant search feature, you can save the search in a special 
folder. This powerful feature allows you to create a virtual folder which, by default, is saved in your 
\\Searches\ folder. Every time you open such a folder, the search results are updated.  

6. In Windows Vista, you can add additional clocks to the system tray. Click the clock, and then click Date 
and Time Settings. Click the Additional Clocks tab. You can add one or two additional clocks to the tray 
and select their time zones.  

7. Those little double arrows appear in many locations throughout the user experience. You'll see them on 
the Quick Launch bar, the notification area, ends of toolbars and more. They simply indicate that either 
more data is available but it's currently hidden from view, or all data is currently displayed but it can be 
hidden or reduced in size. In some cases, the double arrows are a toggle between minimum and 
expanded views; other times, the double arrows display the hidden items when clicked but return to their 
previous display after you make a selection or click somewhere else  

8. You can save your progress in most of the games included with Windows Vista—even the carry-overs 
from earlier versions of Windows.  

9. You can create XML documents, which are more secure than regular text files or even word processor 
docs. Just create a document in a word processor, print it via the options menu, and select the XML 
printer.  

10. In Windows Mail, you can reply to an e-mail with Ctrl+R. Forward one with Ctrl+F.  Send a message 
you've just written by pressing Ctrl+Enter. Send and receive all mail with Ctrl+M.  

11. If you upgrade your graphics card in preparation for Windows Vista, be sure to get a new card with as 
much local memory as possible. Since Windows Vista renders everything—even the desktop and 
windows them-selves—as 3D surfaces, local 3D memory greatly improves performance...sometimes even 
more than a more powerful GPU. 

12. When using the Help system, it's usually advantageous to include Microsoft's online database in your 
search. The online/offline status of your search is located on the bottom right of the Help window. You 
can click it to toggle.  

13. To get to the desktop (minimize all open windows), press the Windows key and M at the same time. To 
reverse the effect, press Shift+Windows+M. This is a real time-saver. If you prefer the mouse, click the 
Show Desktop button in the Quick Launch bar; it does the same thing  

14. Do you use the icon in the upper left corner of system and application windows? A quick double-click 
closes the window (instead of a single click on the X at the upper right). Though Microsoft left the icon 
out in Vista, the function remains.  

15. In Microsoft Windows Explorer, details view, you can use column headers (Name, Size, and so on) to sort 
files. Savvy users may right-click on a column head to remove items or add some—say, Dimensions for 
images. There are around 45 such columns available in Windows XP. Windows Vista has well over 250,  

(Continued from page 3) 

(Continued on page 5) 



Nybbles & Bytes - A Publication of NEOPC Club 

Page 5 

Volume 24, 12 

covering a multitude of metadata.  
16. In Word, Excel and many other applications, Ctrl+F6 is the key that switches between open windows 

within the same app. No need to click on the Window menu in the application and choose the document 
in question. Just cycle through them with Ctrl+F6.  

17. Discover and use right-click shortcuts whenever possible. For example, in Windows Mail, you can easily 
copy the name and e-mail address of someone from the Address Book and paste them into an e-mail. 
People are always asking me for e-mail addresses of mutual friends or colleagues. I click on a person's 
entry in the Address Book and press Ctrl+C (for copy); then I switch back to the e-mail I'm writing and 
press Ctrl+V (paste). Then I press Ctrl+Enter, and the e-mail is sent.  

18. In Internet Explorer, use the F11 toggle to go full screen. This gets all the other junk off the screen. Also, 
use the Search panel to do your Web searches (opened by clicking the magnifying glass search toolbar 
button). You can easily check search results without having to use the Back button. And speaking of the 
Back button, don't bother moving the mouse up there to click Back.  Just press Alt+left arrow. The left- 
and right-arrow buttons with Alt are the same as the Back and Forward buttons.  And, of course, there is 
the Backspace key for moving back.  

19. If you've become used to surfing your Program Menu to get to applications, you'll be in for a shock when 
you first use Microsoft Windows Vista. The new Program Menu shows you only recently used 
applications and requires extra clicks to navigate to submenus. This can be very frustrating but, 
thankfully, the Search box Microsoft has added to the Start menu is a great replacement—as long as 
you're an accurate typist. As quickly as you can type, it returns intelligent results in apps, files, even e-
mail messages.  

20. Change between applications by pressing Alt+Tab. Aiming for an application's little button on the taskbar 
is a hassle. You'll get tendonitis doing that all day. If you're using the Aero interface, you can also use Flip 
3D to change between applications by pressing Windows+Tab. 

 
Drag and Drop Editing in Microsoft Word 

Drag-and-drop editing helps you to move text from one location in a document to another by using 
only the mouse, without using the Clipboard. You simply highlight the text you want to move and use the 
mouse to drag the text to a new location. When you release the mouse button, the text is cut from its original 
location and pasted to the new location.  If you hold down the Ctrl key while dragging text, you can copy the 
text, instead of moving it, to the new location. In other words, the text is not deleted from its original location.  

♦ You can drag and drop text between two open documents, which is easier if both documents are visible 
onscreen. To ensure that both documents are visible, on the menu bar, use Window /Arrange All and 
commence dragging. To drag text from one open document to another without rearranging your windows, 
try this technique:  

♦ Select the text you want to drag to another document. 
♦ Press and hold the mouse button (left). 
♦ While still holding down the mouse button, press Alt+Tab to switch to the document you want to drop the 

text into.  Note: You may have to press Alt+Tab more than once to switch to the right document. 
♦ While still holding down the mouse button, drag the text to the location where you want to drop it. 

(Continued from page 4) 

(Continued on page 6) 
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♦ Release the mouse button to drop the text.   
 
By golly, it works! 
Enable or disable this feature via Tools --> Options. Select the Edit tab and then uncheck the Drag-and

-Drop Text Editing check box or check it to use the feature. 
 

Uncover Windows built-in image resizing utility. 
If you’ve ever had to resize a group of digital picture files, you’ve likely launched your image editing 

program and then resized each image individually — this is an extremely time-consuming task. Windows XP 
has a built-in image resizing utility buried inside the Send Pictures via E-Mail dialog box that can quickly and 
easily resize a large group of digital picture files at once. Forget searching for a batch editor.  Follow these 
steps: 
• Press [Windows] E to launch Windows Explorer.  

Make sure the Tasks pane is visible. (The Folders button acts like a toggle switch. If the Tree pane is 
showing, clicking the Folders button will display the Tasks pane. Click the Folders button if the Tree 
pane is showing.)  

• Copy all the photos you want to resize from different folders to a group in a new folder.   
• Open the folder containing the group of digital pictures you want to resize.   
• Select the group.  
• Under the File and Folder Task list, select the E-Mail the Selected Items command.  
• When you see the Send Pictures via E-Mail dialog box, click the Show More Options link to expand the 

dialog box.  
• Select a radio button next to one of the available sizes and click OK. A new mail message window 

containing the resized digital pictures as attachments will appear.  
• Pull down the File menu, select the Save Attachments command, and save all the attachments to a 

different folder.  
• Close the mail message window and click No in the Save Changes dialog box.  
Portions of this column may have been garnered from several publicly available sources, verified and edited for content.  Where an 
article is used in its entirety without editing, the author and source are acknowledged. 
 

(Continued from page 5) 
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NEOPC & CAGG Volunteer Class Effort 
By Bill Frank & Dick Rose 

It is about time for us to take a little credit and toot our horns for the continued effort  a number of us 
have put forth in the educational training of our members and seniors of our community. As you should 
know by now Elaine Szaniszlo has been conducting her “Ladies Only” classes at the Porter Library for a 
number of years.  Bill and I, along with Jim McIntyre, Rich Kolofer, Dave Vydra, Lou Loesch, and Bob 
Minnich are now in our eighth year of teaching at the Fairview Park Senior Center. Our tally so far is  825 
Seniors, having spent 6531 class hours, to date. We conduct a series of 18 different classes on varied topics.  

Any of you who are 55 or older can participate in our classes after having pre-qualified and sub-
scribed to the classes of choice as determined in an “Orientation Class” which we conduct once a month for 
prospective new enrollees.  Come to the Orientation if interested.  

We can’t overlook our own Lee Gerber and his contribution to the educating us all in the twice 
monthly Fundamentals Workshops. See the schedule calendar below: 

Here is our September class Calendar: 
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